
Laborator 6 
Crearea unei baze de date in Microsoft Access 

 

 Microsoft Access este un sistem de gestiune a bazelor de date care poate fi utilizat pentru 

a creea și a administra baze de date. Acesta face parte din pachetul Microsoft Office și este 

disponibil alături de alte programe 

 Bazele de date din Access sunt compuse din 4 obiecte și anume: tabele, interogări, 

formulare și rapoarte.  

 În Access, toate datele sunt organizate în tabele (Tables). Coloanele acestora sunt denumite 

câmpuri și fiecare dintre acestea e caracterizat de un tip de dată și implicit de o dimensiune 

specifică, iar liniile se mai numesc și înregistrări. 

 Formularele (Forms) sunt folosite pentru a facilita introducerea, modificarea și vizualizarea 

articolelor unui tabel cu ajutorul unui șablon. Formularele se folosesc atât de frecvent datorită 

ușurinței cu care utilizatorul este ghidat să întroducă corect datele, fără a mai fi nevoie să caute 

câmpurile din tabelele unde se dorește a fi completate datele. 

 Interogările (Queries) sunt folosite pentru a regăsi și prelucra datele. Acestea pot lucra cu 

date din mai multe tabele pe baza anumitor criterii, pot actualiza date și pot efectua calcule cu 

acestea. 

 Rapoartele (Reports) sunt modalitatea de a extrage datele din tabele și interogări și de a 

trimite aceste date la imprimantă. Aceste rapoarte pot fi personalizate pentru a atrage mai mult 

atenția. Legătura care există între acestea este sugestiv prezentată în figura 13.1. [13] 
 

-  
-- 

Fig. 1. Legătura dintre obiectele unei baze de date în Access 

 

 În momentul deschiderii aplicației Access, se deschide meniul File de unde utilizatorul 

poate alege anumite template-uri (șabloane) predefinite, precum și opțiunea de a creea o nouă bază 

de date (Blank Database).  Tot în cadrul acestui meniu utilizatorul poate să specifice fișierul unde 



se dorește salvarea bazei de date și numele acesteia. De asemenea, o listă cu bazele de date recent 

create este disponibilă în partea stângă a ferestrei. 

 Prin dublu-click asupra opțiunii Blank Database, noua bază de date se dechide pentru a 

putea fi construită sau se va cere o locaţie de stocare şi un nume pentru aceasta. [21], [25] 

 

Crearea de tabele și câmpuri 

  

 În momentul deschiderii noii baze de date creată, utilizatorul va observa că pe ecran va 

apărea un tabel implicit, denumit Table1, după cum se poate observa atât în partea de sus a 

tabelului, cât și în panoul de navigare din partea stângă a ferestrei. 

 

 
 

Fig. 2. Crearea unui tabel in Access 

 

 Pentru a redenumi acest tabel după necesitățile bazei de date, prin click-dreapta pe 

denumirea tabelului se va selecta opțiunea Save sau se va folosi meniul File->Save și se va 

redenumi tabelul. 

 În cazul în care se dorește redenumirea tabelului se va merge în panoul de navigare, se va 

da click dreapta pe numele tabelului și se va alege opțiunea Rename. Se face precizarea că această 

opțiune se poate folosi doar în cazul în care tabelul a fost închis în prealabil. Tot din meniul afișat 

în acest caz se poate deschide sau închide un tabel deja existent. 

 Pentru a creea un nou tabel în cadrul bazei de date care se dorește a fi creată se alege din 

meniul Create opțiunea Table. 

 Dacă tabelul a fost închis, acesta rămâne în panoul de navigare şi se poate vizualiza în cazul 

în care utilizatorul va da click-dreapta pe numele acestuia şi va alege opţiunea Open sau dacă va 

da dublu click pe numele acestuia.  



 În cadrul Acces, utilizatorul va putea adăuga câmpuri noi în cadrul unui tabel dacă se 

lucrează în Datasheet view sau Design view. Aceste 2 opțiuni pot fi accesate din meniul Home-

>View. În continuare se vor puncta diferențele dintre aceste 2 opţiuni.[25] 

 

 
 

Fig. 3. Meniul View 

 

 În Datasheet view se vor introduce datele direct în tabel, alegându-se în prealabil tipul de 

dată al câmpului curent. În mod implicit, Access crează un câmp în fiecare tabel nou, câmpul ID. 

Acesta este predefinit ca auto-number pentru a genera pentru fiecare înregistrare nouă un număr 

unic de identificare. Pentru a adăuga un nou câmp, un click pe Click to add va deschide un meniu 

de unde se poate alege tipul noului câmp. De asemenea câmpul nou creat poate fi redenumit. 

 Adăugarea înregistrărilor cu ajutorul Design View este mai precisă deoarece anterior 

introducerii datelor în tabele se definesc numele şi tipul câmpurilor. 

 Dacă se dorește modificarea tipului datelor în Design View se va face prim poziţionarea 

cursorului pe tipul de date care se doreşte a fi modificat şi alegerea tipului dorit din meniul pop-

up care va apărea. 

 În cazul în care se doreşte rearanjarea ordinii de apariţie a câmpurilor în tabel se foloseşte 

comanda de tipul drag-and-drop, iar dacă se doreşte eliminarea unui anumit câmp se va selecta 

acest câmp şi se va apăsa tasta Delete.  

 

Exemplu: 

 Pentru a exemplifica modul de creare al unui tabel, se va creea tabelul Laboratoare din baza 

de date utilizată pentru gestionarea laboratoarelor. 

 Astfel, după ce a fost deschisă baza de date pentru a fi creată cu Blank Database, alegem 

din meniul Create opţiunea Table pentru a creea un nou tabel. Pentru a introduce în noul tabel 

câmpurile, se va alege una dintre cele 2 modalităţi enunţate mai sus. În acest exemplu vom alege 

să lucrăm în Design View. Fereastra de Save as apare, iar utilizatorul poate să denumească tabelul 

Laboratoare. 

 În noua fereastră apare ca fiind definit doar câmpul predefinit şi anume ID de tipul 

AutoNumber. Vom introduce încă 4 câmpuri şi anume Denumire, Adresa, Contact, ID_responsabil. 



Câmpurile se introduc prin scrierea numelor lor, iar din meniul de tip pop-up care apare în partea 

dreaptă  se alege tipul datelor ce vor fi conţinute de către acesta. [13],[25] 

 

 
 

Fig. 4. Definirea câmpurilor tabelului în Design View 

 

 Se poate observa că cheia primară este deja definită ca fiind câmpul ID, dar pot fi făcute 

modificări ulterioare. Dacă vom lucra cu Datasheet View, câmpurile tabelului se vor defini la fel 

ca aici, prin definirea tipului şi scrierea numelui după ce s-a dat click pentru a le adăugă, rezultatul 

fiind cel de mai jos. 

 

 
- 

Fig. 5. Definirea câmpurilor tabelului în Datasheet View 

 

 Tipurile de date de bază admise de către Access sunt următoarele: 

 

Tabel 1. Tipuri de date 

Text 

LongText 

ShortText 

Majoritatea câmpurilor folosite în baza de date sunt de tipul text. Pe lângă câmpurile 

care au tipul evident text, cum ar fi: Nume, Adresa, câmpurile text se mai pot folosi 

şi pentru numerele care nu au funcţie matematică. De exemplu, se folosesc câmpurile 

text pentru stocarea numerelor de telefon, a codului poştal etc. 

 Dimensiunea prestabilită a unui câmp text în Access este de 50 caractere, dar putem 

alege orice dimensiunea între 1 şi 255. 

 

Number Tipul număr (Number) include mai multe tipuri care diferă prin modul de stocare şi 

viteza de răspuns. Acestea sunt: 

1. tipul Byte (Octet), care acceptă numai valori întregi pozitive până la 255 



2. tipul Integer (întreg), care acoperă domeniul numerelor întregi de la -32768 la 

32768 

3. tipul Long Integer (Întreg lung), care reprezintă numerele întregi până dincolo de 

limitele de plus şi minus 2 miliarde 

4. tipul Single, care acoperă domeniul numerelor fracţionare cu până la 7 cifre 

semnificative 

5. tipul Double, care acoperă domeniul numerelor fracţionare cu până la 14 cifre 

semnificative 

6. tipul ReplicationID (IdentificatorDuplicare), care este reprezentată pe 16 octeţi şi 

a fost creată cu scopul de a asigura un identificator unic global (GUID: Globally 

Unique Identifier) pentru bazele de date în cazul cărora trebuie realizată sincronizarea 

unor mari cantităţi de date suplimentare, de la mai multe situri. 

 

Curency Tipul valută (Currency) acoperă valorile în dolari întregi până la 15 cifre şi valorile 

zecimale până la sutimi de cent. Ca reprezentare internă, tipul valută este un număr 

în virgulă fixă. Acest format asigură o precizie sporită calculelor financiare, dar este 

mai lent decât tipurile de numere întregi sau în virgule mobile 

 

Yes/No Tipul Da/Nu (Yes/No) stochează numai valori true sau false (adevărat sau fals). O 

astfel de valoare poate fi afişată în una din formele True/False, Yes/No sau On/Off. 

 

Date/Time Microsoft Access stochează intern datele calendaristice sub forma unor numere în 

virgulă mobilă pe 8 octeţi, ora fiind reprezentată ca o fracţiune dintr-o zi. În general 

este suficientă în majoritatea situaţiilor opţiunea Short Date (Forma scurtă a datei), 

deşi s-ar putea să dorim ca anul să fie reprezentat pe formatul de 4 cifre. 

 

Calculated 

field 

Rezultatele unui calcul. Calculul trebuie să se refere la alte câmpuri din același tabel. 

Se va folosi Expression Builder pentru a creea calculul 

 

Attachment Imagini atașate, fișiere de tip excel, documente, grafice și alte tipuri de fișiere 

suportate  

 

Hyperlink Un link către un site 

 

Memo Dimensiunea unui câmp de tipul Memo este de 64KB (kiloocteţi), asta însemnând că 

putem stoca aproximativ 16 pagini de text scris la un rând pentru fiecare înregistrare. 

Câmpurile memo constau numai din text. Pot fi incluse secvenţe de salt la început de 

rând sau salt la rând nou, dar nu se acceptă opţiuni de formatare a textului sau 

indentarea unui paragraf. 

 

Lookup Programul wizard de căutare (Lookup Wizard) nu este câtuşi de puţin un alt tip de 

câmp. El reprezintă o metodă convenabilă de crearea a unui câmp care îndeplineşte 

funcţia de căutare într-un alt tabel. 

 

OLE Object Tipul de câmp OLE este destinat păstrării datelor provenite de la alte programe, care 

s-au înregistrat ele însele ca servere OLE în Windows.Aceasta permite bazei de date 

să stocheze documentele create de programe de prelucrare a textelor, seturi de foi de 

calcul, ilustraţii, sunete, videoclipuri, etc. 

 



 Odată definite coloanele tabelului, utilizatorul va introduce datele în tabel, iar rezultatul 

introducerii acestora în tabelul laboratoare va fi următorul: 

 

 
- 

Fig. 6. Tabelul laboratoare 

 

 În cazul în care în cadrul tabelului avem mai multe chei primare, acestea vor fi definite cu 

ajutorul Design View. 

 

Exemplu: 

 Dacă este să luăm ca exemplu tabelul lab_ap, acesta va avea două chei primare şi anume ID_lab 

şi ID_ap. Pentru a face această setare, se merge în Design View, se selectează cele două coloane 

şi se selectează icoana . Rezultatul va fi cel prezetat în figura 13.7, unde ambele 

câmpuri au simbolul unei chei în faţă, simbolizând faptul că ambele sunt chei primare. De 

asemenea, pentru a edita ID_lab, se va schimba tipul acestuia din AutoNumber în Number. 

 

 
 

Fig. 7. Definirea unei chei primare create din mai multe câmpuri 

 

 Validarea datelor este un concept foarte important dintr-o baza de date. Aceste este 

procesul prin care Access testează datele care sunt inserate în baza de date pentru a se asigura că 

acestea au un format valid. Access are opţiunea de a lăsa utilizatorul să seteze proprietăţi pentru 

câmpurile din tabele (field properties) şi de asemenea să impună reguli de validare a datelor 

(data validation rules). 

 Validarea datelor începe încă din momentul în care se inserează valori in tabel. De 

exemplu, dacă o dată este setată de tipul Number, iar în tabel se introduce un text, Access va afişa 

Validation error. 

 



 
 

Fig. 8. Eroarea apărută în cazul disconcordanţei dintre tipul de date ce trebuie introdus şi -datele introduse de 

utilizator 

 

 Setarea regulilor de validare a datelor se poate efectua în Design View. Pentru a seta 

aceste reguli se va selecta câmpul pentru care se doreşte o regulă de validare. Se va accesa din 

Property Sheet opţiunea Validation Rule, iar apoi cu un click pe linia punctată se va deschide 

fereastra de Expression Builder care are sintaxa necesară pentru a putea seta noua regulă de 

validare. 

 Pentru a deschide Expression Builder se mai poate selecta icoana   care apare în Table 

Tools în unele versiuni de Access. 

 

Exemplu: 

 De exemplu pentru laboratoare se poate impune condiţia ca dacă ID_responsabil este mai 

mare decât 5 să nu fie validată informaţia, considerând că pentru laboratoare ar putea fi numiţi 

maxim 5 responsabili. Acest lucru se poate scrie precum în imaginea de mai jos.[25] 

 

 
 

Fig.9. Inserarea de condiţii pentru validarea datelor 

 



 Prin selectarea opţiunii Validation Text se poate insera un mesaj de eroare care îi poate 

transmite utilizatorului ce valori poate lua acel câmp. 

 De exemplu dacă utilizatorul a introdus un număr pentru responsabil mai mare de 5, pe 

ecran va apărea mesajul Nu pot exista mai mult de 5 responsabili. Mesajul definit după cum este 

menţionat mai sus va apărea sub forma prezentată în Fig. 10. 

 

  
 

Fig. 10. Afişarea unui mesaj de eroare predefinit 

 

 Sortarea şi filtrarea înregistrărilor 
  

 Sortarea și filtrarea sunt instrumente care ajută utilizatorul să organizeze datele. Sortarea 

se referă la aranjarea în ordine a datelor. Filtrarea datelor lasă utilizatorul să ascundă datele 

neimportante și să se focalizeze numai pe datele care sunt de interes. 

 Pentru a sorta un câmp (coloană ) dintr-un tabel se selectează acestă coloană. Apoi din tab-

ul Home-> Sort& Filter se alege modul de sortare dorit ,  sau . După 

sortare, dacă se dorește păstrarea acestui format al tabelului, se va salva cu Save. Pentru a elimina 

o sortare, se va alege . 

 Filtrarea este utilă deoarece permite vederea numai a datelor de interes. Pentru a creea un 

filtru, se setează criteriul de sortare, după care filtru va căuta toate datele din tabel, le găsește pe 

cele de interes și ascunde temporar toate celelalte date. 

 Pentru a creea un simplu filtru, se dă click pe săgeata din dreapta numelui câmpului asupra 

căruia se impune filtrul și un meniu drop-down va apărea.  Se bifează elementele ce se dorește a fi 

incluse în rezultat, după care se apasă butonul OK. Cu ajutorul  care devine activ se 

poate activa și dezactiva filtrul. 

 

 



Exemplu:  

 Se doreşte sortarea câmpurilor din tabelul laboratoare astfel încât să se afişeze toate 

laboratoarele care sunt pe strada Bariţiu.  

 Primul pas este setarea condiţiilor de sortare, după care se apasă OK. Pentru a vedea 

valorile din tabel cu şi fără filtrul impus se foloseşte Toggle Filter. Pentru a elimina filtrele vom 

putea acccesa opţiunea Advanced->Clear all Filters 

 

  
 

Fig. 11. Definirea condiţiilor de filtrare 

 

 Pentru a creea un filtru dintr-o selecție se va selecta o celulă sau o dată pe baza căreia se 

dorește să se creeze filtrul. Din tabul Home-> Sort& Filter se va alege Selection și se selectează 

tipul de filtru care se dorește a se impune pentru elementele tabelului. Utilizatorul poate alege între: 

 equals care va avea ca rezultat afișarea tuturor înregistrărilor care au date identice cu datele 

selectate 

 does not equal care va avea ca rezultat afișarea tuturor înregistrărilor cu excepția celor celor 

care conțin date identice cu datele selectate 

 contains care va avea ca rezultat afișarea tuturor înregistrărilor cu celule care conțin datele 

selectate 

 does not contain care va avea ca rezultat afișarea tuturor înregistrărilor cu excepția celor care 

conțin celule care au in componență datele selectate 

În momentul în care se dorește filtrarea datelor de tip numeric, în tabul tabul Home-> 

Sort& Filter când se va alege Selection, vor apărea opțiuni de filtrare diferite și anume: Equals, 

Does not Equal, Greater Than, Lass Than, Between.  

 

Exemplu: 

 Pentru a afişa doar laboratoarele de la adresa Str. Bariţiu nr 26 vom da click pe una din 

adrese şui vom alege opţiunea Text Filters -> Cotains care va determina apariţia unei noi ferestre. 



Utilizatorul introduce cuvintele după care se face sortare şi care trebuie să fie conţinute în 

câmpurile tabelului pentru a fi afişate.  

 În cazul filtrării unor date de tip numeric, procedeul este aproximativ identic. 

 

 
 

Fig. 12. Definirea condiţiilor de filtrare cu Text Filters 
 

 

 Crearea relaţiilor dintre tabele 
 În momentul în care tabelele necesare pentru baza de date au fost create şi populate cu date 

este necesară definirea relaţiilor dintre acestea. Pentru a stabili aceste legături, utilizatorul va trebui 

să acceseze meniul Database Tools unde va găsi butonul Relationships. 
 

 
 

Fig. 13. Definirea relaţiilor dintre tabele 

 În momentul în care apare fereastra de dialog Show Table, se vor alege toate tabelele şi se 

va da click pe opţiunea Add. Pe ecran, în fereastra unde se vor stabili relaţiile vor fi afişate toate 

tabelele care au fost selectate 

 



 
 

Fig. 14. Crearea diagramei de legătură între tabelele bazei de date 

 

 Pentru a putea defini legăturile dintre tabele, utilizatorul trebuie să facă legătura dintre 

cheia primară din fiecare tabel şi cheile străine care fac referire la aceasta. Legătura dintre tabele 

se poate efectua în 2 moduri şi anume: 

 1. prin accesarea din meniul Design a instrucţiunii Edit Relationship  

 -se va deschide o fereastră unde se vor alege cele 2 câmpuri care fac legătura între cele 

două tabele  

 -se selectează Enforce Referential Integrity: acestă opţiune face ca Access să verifice 

dacă există concordanţă între datele celor două tabele 

 -se apasă tasta Create 

 

 
 

Fig.15. Definirea legăturilor dintre tabele 

 



 
 

Fig. 16. Diagrama bazei de date creată 

 

 2. prin metoda Drag and Drop, care este mai rapidă care constă în alegerea unui câmp dintr-

unul dintre tabele şi, menţinând apăsat click dreapta, legarea acestuia la câmpul de legătură dintre 

cele 2 tabele. 

   

Crearea formularelor 
  

 O altă modalitate de a popula o bază de date este folosirea formularelor. Rolul formularelor 

este de a ajuta persoana care introduce datele să ştie exact ce informaţii să introducă. În viaţa de zi 

cu zi, un formular este o foaie de hârtie care se completează cu date personale ca acestea să se 

poată colecta şi memora. 

 Deoarece o bază de date cu informaţii poate să conţină sute de înregistrări şi multe câmpuri 

de completat, ea poate fi copleşitoare pentru persoana care introduce date. Un formular Access 

ajută la introducerea datelor înregistrare cu înregistrare, fară a fi nevoită să vadă tot tabelul. De 

asemenea, aceste formulare sunt foarte precise cu privire la ce date trebuie introduse, putându-se  

insera chiar şi meniuri de tip drop-down , care cresc considerabil integritatea datelor. Şi în cazul 

formularelor accesul persoanelor poate fi limitat, ceea ce face ca datele să fie mai protejate. [25] 

 

 Crearea unui formular 

 Access face ca procesul de creare a formularelor pe baza oricărui tabel să fie ușoară. Orice 

formular nou creat permite vederea datelor care se regăsesc deja în tabel și  de asemenea lasă 

utilizatorul să introducă noi date. După crearea unui formular, acesta poate fi modificat prin 

adăugarea unor câmpuri adiționale. 



 Pentru a creea un formular, din panoul de navigare se selectează tabelul pentru care se 

dorește să se creeze un nou formular; nu e necesară deschiderea tabelului. Următorul pas este 

selectarea din Forms a tabului Create. La selectarea butonului , se va creea și se va deschide 

formularul corespunzător tabelului ales în Layout View. Pentru a salva acest formular, se apasă 

Save și se denumește formularul. 

 

Exemplu: 

 Pentru a creea formularul corespunzător tabelului aparatură se selectează acesta din panoul 

de navigare şi se selectează Create-> Forms. Formularul nou creat se poate observa în imaginea 

de mai jos. 

 

  
 

Fig. 17. Formularul creat pentru tabelul responsabili 

 

 În cazul în care se crează un formular dintr-un tabel a cărui înregistrări sunt legate de alte 

tabele, formularul va conține un subformular.  

 Un subformular reprezintă un tabel care conține înregistrări care au legătură cu datele din 

tabelul pentru care s-a creat formularul. Dacă nu avem nevoie de acest subformular, el poate fi 

șters. 

 Un astfel de exemplu este un formular creat pentru tabelul lucrari_de_lab care are legături 

cu lucrarilab_aparate. 

 



 
 

Fig.18. Formularul creat pentru tabelul lucrari_de_lab 

 

 Adăugarea unor câmpuri suplimentare unui formular 

  

 Atunci când se creează un formular pe baza unui tabel existent toate câmpurile acelui tabel 

se vor  regăsi în acel formular. Cu toate acestea, dacă sunt adăugate mai târziu câmpuri în tabel, 

formularul nu va fi updatat. În acest caz, se pot adăuga noi câmpuri în formular cu ajutorul Form 

Layout Tools->Design->Add Existing Fields . În cazul în care această opţiune nu este 

prezentă, se va da click dreapta pe numele formularului deschis şi se va alege opţiunea Layout 

View. În acest caz va apărea o listă cu câmpurile tabelelor de unde utilizatorul poate să selecteze 

ce câmp mai dorește să fie afișat. 

 De asemenea un formular poate fi creat de la început fără a fi selectat un tabel anume, 

introducând câmpurile dorite prin aceeași metodă prezentată mai sus și selectând  [25] 

 

 Adăugarea unor controale de proiectare (design controls) 

 

 Controalele de proiectare sunt restricții aplicate câmpurilor din formulare. Acestea ajută la 

obținerea unui control mai bun asupra datelor din formulare, și deci oferă consistență bazei de date. 

  Când ne referim la un combo box ne referim de fapt la o lista de tipul drop-down care se 

poate folosi în formulare sub formă de câmp. Acestea limitează informația pe care utilizatorul o 

poate introduce prin forțarea acestuia să selecteze una din opțiunie care sunt specificate. Acestea 

sunt foarte utile pentru câmpurile care au un număr limitat de informații valide posibile. 

 Pentru a creea un combo box se selectează din Form Layout View->Form Layout Tools 

Design icoana pentru Combo Box . Cursorul, care își va modifica forma , va fi poziționat 



unde se doorește introducerea acesui meniu și se va da click.  În continuare, fereastra de Combo 

Box Wizzard va apărea  și se va selecta opțiune de I will type in the values I want. În tabelul 

care va apărea se trec opțiunile care se dorește să apară în meniul de tip drop-down. Se va alege 

de asemenea o dimensiune convenabilă  a coloanei și se trece la următorul pas unde se va selecta 

Store the value in this field și se alege una dintre opțiunile din lista care conține câmpurile din 

tabel, pentru care a fost creat Combo Box. Ultimul pas este scrierea denumirii care va apărea lângă 

această listă în formular. 

 

Exemplu: 

Se va creea un formular pentru tabelul lab_ap cu opţiunea Blank Form. Se va selecta 

opţiunea Combo Box, care ne va duce la Combo Box Wizard. Vom dori să creăm un formular care 

să lase utilizatorul să aleagă o valoare pentru ID_lab între 1 şi 6 deoarece în baza noastră de date 

există doar 6 laboratoare. Vom scrie în coloana care apare numerele de la 1 la 6 şi vom denumi 

Combo Box-ul ID_lab. 

Câmpurile ID_ap şi nr_ap vor fi preluate din lista din dreapta. Astfel formularul a fost creat 

şi poate fi salvat. Pentru a putea fi folosit formularul se da click dreapta pe numele acestuia şi se 

trece la Form View.[25] 

 

     
 

 
 

Fig. 19. Crearea unui Combo Box 

 

 



Personalizarea setărilor formularului cu ajutorul foii de proprietăți (Property Sheet) 

 Property Sheet este un meniu care conține informații detaliate despre formulare si toate 

componentele acestora. De aici se pot face schimbări din punct de vedere al funcției formularului, 

dar și din punct de vedere al aspectului acestuia. 

 Pentru a ascunde unul dintre câmpuri, din Form Layout Field-> Design se selectează 

Property Sheet  . În partea dreaptă a ecranului apare un meniu. Se va selecta din formular 

câmpul care se dorește a fi ascuns și se alege din meniul Format, la opțiunea Visible-> NO. 

 Pentru a selecta un câmp să se auto-seteze pe data curentă se selectează  câmpul dorit (care 

trebuie să fie de tipul date) din formular, apoi din Property Sheet se va selecta din meniul numele 

coloanei de tip dată calendaristică, iar din Data se va selecta Default Value. 

 

 
 

Fig.20. Setarea unei date dintr-un formular pe data curentă 

 

 Mai apoi fereastra de Expression Builder va apărea. Se va selecta Common Expresions-

> Current Date. 

 

Crearea interogărilor 
 Importanța unei baze de date relaționale provine din abilitatea de a regăsi și a analiza rapid 

datele prin rularea unei interogări. Interogările au rolul de a prelua informații din unul sau mai 

multe tabele bazându-se pe un set de condiții de căutare definite de către utilizator. Datorită 

faptului că datele pot fi preluate din mai multe tabele, interogările sunt mult mai puternice decât o 

simplă căutare sau un filtru aplicat unui tabel. 



 Rezultatele unei interogări vor fi conținute într-un tabel, dar când acesta este proiectat se 

folosește o vedere diferită de cele amintite anterior. Această vedere este denumită Query Design 

View. 

 Dacă se dorește interogarea a mai mult de un tabel, se va folosi una dintre opțiunile Query 

Design   sau Query Wizard  . 

 Pentru a planifica o interogare utilizatorul va trebui să definească în prealabil 3 lucruri și 

anume: 

 cum se dorește a fi reprezentat rezultatul-se identifică fiecare câmp care se dorește a fi inclus 

în rezultat 

 unde se găsește informația dorită în baza de date – care sunt tabelele care interesează 

 care sunt condițiile care trebuie îndeplinite de către date – se definesc criteriile de afișare ale 

datelor 

 

Folosirea comenzii Query design 

 

Odată ce interogarea a fost planificată, se urmează următorii pași pentru a ajunge la un 

rezultat: 

 Se selectează Create->Query Design   

 Accesarea acestei opțiuni ne va duce Query Design View. Va apărea o fereastră denumită 

Show Table  din care se vor selecta tabelele pe care se dorește aplicarea interogării, după care 

se alege opțiunea Add 

 Tabelele selectate vor apărea ca o fereastră mică în Object Relationship Pane . Prin dublu 

click se vor alege din tabelul afișat câmpurile care se doresc a fi incluse în interogare. Acestea 

vor fi incluse în tabelul denumit Design Grid care apare în partea de jos a ecranului; această 

operațiune se poate face și cu ajutorul drag and drop 



 

Fig.21. Crearea interogărilor cu Query Wizzard 

 

 Mai departe se vor seta criteriile de căutare prin click pe celula care aparține liniei de tabel 

Criteria; pentru anumite câmpuri se pot seta astfel filtre 

 Odată ce criteriile au fost selectate, se va apăsa butonul Run din grupul Results din bara de 

meniu    

 Rezultatele sunt create și se vor verifica de către utilizator[25] 

 

Exemplu:  

Dacă dorim să afișăm numele laboratorului și a aparaturii care aparține acestui laborator se vor 

selecta tabelele aparatura și laboratoare, după care se vor seta criteriile de căutare și ceea ce va fi 

afișat în urma interogării.  

 

 



 
 

Fig. 22. Crearea interogărilor care afișează laboratoarele și aparatura 

 

 Ascunderea câmpurilor sau a altor informații din cadrul rezultatului 

 

Câteodată rezultatele unei interogări vor include informații care nu au relevanță. Access 

permite utlilzatorului să ascundă cu ușurință aceste informații. Acest lucru este posibil dacă în 

fereastra de Query Design se deselectează opțiunea Show, după care se rulează din nou interogarea. 

 

 Salvarea unei interogări 

 

Pentru a salva rezultatele obținute în urma unei interogări se va da click dreapta pe tabul 

deschis pentru afișarea rezultatului și se va selecta Save, după care utilizatorul va putea denumi 

această interogare. Dacă dăm click dreapta pe numele interogării și alegem SQL View, se va afișa 

codul SQL pentru interogarea aleasă. De asemenea se poate introduce codul SQL în SQL View și 

rezultatul va putea fi obținut în același mod. 

 

 Utilizarea operațiilor matematice în interogări 

 

Uneori se dorește ca în cadrul unei interogări să se grupeze sau să se numere rezultatele. 

Acest lucru este posibil prin utilizarea unor funcții foarte asemănătoare cu cele din Excel are se 

găsesc Query Tools-> Design   . Aceste funcții includ: Sum, Average,Maximum, Minimum, 

Count 

Când se vor folosi comenzi din Totals în cadrul interogării, Access va grupa automat 

fiecare câmp în funcție de valorile din fiecare câmp prin funcția Group by. La apăsarea butonului 

Totals, linia Total va apărea în tabelul din partea de jos a acranului. În momentul în care dăm click 

pe Group by, va apărea o listă cu opțiuni de unde se poate alege ce operație dorim să se efectueze 

asupra câmpului pe care suntem poziționați. Mai apoi se alege Run și se pot vizualiza soluțiile. 

  

Exemplu: 

 



  Pentru a afișa adresa și suma suprafeţelor tuturor laboratoarelor care se găsesc la aceeaşi 

adresă se va alege pentru interogare tabelul laboratoare, se selectează pentru a fi afișate adresa și 

suprafața, după care se apasă  și se alege pentru suprafața SUM, după care se rulează 

interogarea.[25] 

 

       
 

Fig. 23. Crearea interogării și rezultatul afișat 

 

 Sortarea și filtrarea rezultatelor unei interogări 

 

Odată ce rezultatele dorite au fost obținute, acestea pot fi sortare și filtrare pentru a 

restrânge rezultatele și mai mult. Acest lucru se poate efectua prin click pe linia Sort  din câmpul 

care se dorește a fi sortat. Va apărea o listă de unde se poate alege una dintre opțiunile 

crescător(Ascending) sau descrescător (Descending). Pentru a se vedea rezultatele se va rula din 

nou interogarea. 

 Pentru ca rezultatele să fie filtrate se va da click pe linia Criteria din câmpul care se dorește 

a fi sortat, după care se adaugă criteriul de sortare și se rulează interogarea.  

 

Exemplu: 

Dacă dorim să afișăm numele laboratorului și responsabilii care se ocupă de  acest laborator, 

în ordinea alfabetică a denumirii laboratoarelor, se vor selecta tabelele laboratoare și responsabili 

și ceea ce se va afișa din acestea, iar la Sort se va alege opțiunea Ascending pentru denumirea 

laboratoarelor. 

 

 

Fig. 24. Definirea coloanelor ce vor fi afișate cu sortarea aferentă 

 

 



Crearea unor rapoarte 
 

Dacă se dorește împărtășirea datelor dintr-o bază de date cu cineva anume dar nu se dorește 

ca această persoană efectiv să lucreze cu această bază de date, se va crea un raport. Rapoartele 

permit organizarea și prezentarea datelor într-un format atractiv și user-friendly. 

Pentru a creea un raport se vor urma următorii pași: 

 se va deschide tabelul sau interogarea pentru care se dorește crearea unui raport  

 se va selecta Create->Reports-> , iar Access va creea un nou raport bazat pe obiectul 

studiat 

 se va salva raportul la fel ca și în cazul formularelor și interogărilor  

 dacă se dorește sortarea sau filtrarea unui câmp, se va da click dreapta pe acesta și se va alege 

opțiunea dorită 

 ștergerea unui anumit câmp din raport se face prin alegerea celulei care se dorește ștearsă și 

delete 

 pentru a lista un raport, pentru a ne asigura că acesta este bine poziționat în pagină se selectează 

View->Print Preview și se vor face modificările necesare cu privire la mărimea paginii, 

marginile și orientarea acesteia;se poate ajunge la această opțiune prin click dreapta pe 

denumirea raportului din Navigation Panel.  

Rapoartele se pot salva și în alte formate pentru a fi accesibile și fără Access. Acest proces 

se numește exportarea unui fișier și permite utilizatorului să modifice rapoartele care se regăsesc 

în alte formate și programe. Access oferă posibilitatea de a salva un raport în următoarele formate: 

Excel, Text, PDF, XPS,  email attachment, Rich Text, sau HTML document. Pentru a exporta 

un raport se procedează astfel: 

 se accesează Home->Print Preview->Data 

 se selecteză una dintre categoriile de fișiere din Data sau se dă click pe More pentru a vedea 

alte opțiuni.  

  

Opțiuni avansate pentru crearea rapoartelor 

 

Microsoft Access oferă câteva opțiuni avansate de crearea și modificare a 

rapoartelor. Report Wizard ghidează utilizatorul prin procesul de creare a unor rapoarte mai 

complexe din multiple tabele  și obiecte. Acesta asigură alegerea de către utilizator până și a 

modului în care datele vor fi organizate. 

Iată modul de folosire al Report Wizard: 

 se alege Create->Reports->Report Wizard care va deschide fereastra de dialog Report 

Wizard  

Pasul 1:Selectarea câmpurilor ce vor fi în raport 



 se vor alege tabelele sau interogările care conțin câmpurile care se doresc a fi cuprinse în raport 

din meniul de tip drop-down conținut de această fereastră 

 -se selectează un câmp din lista din dreapta și se apasă săgeata către dreapta pentru a-l adăuga 

la raport; se va efectua repetat acest process pâna când toate câmpurile dorite sunt adăugate la 

raport, după care se  trece la pasul următor apăsând Next 

Pasul 2: Organizarea raportului 

 Report Wizard oferă opțiuni care permit utilizatorului definirea modului de organizare al 

datelor;  

 astfel, Access oferă o listă cu diferite moduri de organizare a datelor;utilizatorul va accesa una 

dintre acestea și va putea previzualiza modul de organizare în partea dreaptă a ferestrei, iar 

dacă este satisfăcut de alegerea sa va trece la următorul pas. 

 în cazul în care modul de organizare nu este cel dorit, se pot modifica nivelele de grupare astfel: 

 pentru a adăuga un nou nivel de grupare se selectează un câmp din lista din partea stângă a 

ecranului și cu ajutorul săgeții dreapta se introduce între nivelele de grupare; dacă este necesară 

modificarea ordinii nivelelor de grupare, se selectează câmpul care se dorește mutat și se 

modifică poziția cu ajutorul săgeților sus și jos; odată ce e stabilită ordinea dorită se apasă 

butonul Next 

Pasul 3: Sortarea datelor dintr-un raport  

 în noua fereastră de lucru se va selecta numele primului câmp care se dorește sortat și se dă 

click pe butonul care definește tipul sortării:crescător sau descrescător 

 se pot adăuga până la 4 câmpuri pentru a fi sortate, fiecare cu gradul său de imprtanță, începând 

de sus în jos, iar pentru a trece la pasul următor se dă click pe Next 

 Pasul 4: Selectarea aspectului și a titlului 

 în cadrul acestui pas se poate alege orientarea paginii și aspectul acestuia  

 în următoarea fereastră se va scrie titlul raportului și se va alege preview pentru a vedea cum 

arată raportul sau modify pentru a-l modifica, după care se apasă butonul Finish pentru a creea 

și salva raportul[26] 

 

Exemplu: 

 

 Dacă dorim să afișăm numele laboratorului și responsabilii care se ocupă de  acest 

laborator, în ordinea alfabetică a denumirii laboratoarelor, grupate după numele responsabililor, 

se vor urma următorii pași: 

 



     
 

     
 

     
 

Fig. 25. Pașii urmați pentru crearea unui raport cu Report Wizzard  

 

Formatarea rapoartelor 

 

 Pentru a vedeam și modifica header-ul și footer-ul care apare pe fiecare dintre paginile 

raportului, se selectează View->Design View; informațiile care ne interesează se vor plasa sub 

Page Header și Page Footer. Pentru a adăuga text  în aceste porțiuni, se selectează Design->Report 

Design Tools->Controls->Label și se plasează cursorulîn zona unde se va introduce text; cu 

ajutorul mouse-ului se creează porțiunea unde va fi introdus textul. 

 Pentru a introduce data și timpul se va selecta Report Design Tools->Header/Footer-

>Date and Time și se selectează formatul de afișare. 

 Pentru a adăuga numerotarea paginilor se selectează Report Design Tools-

>Header/Footer->Page Numbers 



 O altă posibilă acțiune este adăugarea unui logo prin selectarea View->Layout View -

>Header/Footer->Design ->Logo. Va apărea o fereastră Insert Picture de unde se poate allege 

imaginea pentru Logo. De asemenea, pentru a schimba tema raportului se acceseaza Design-

>Themes, se unde se pot alege culori și fonturi pentru raport.  

 

Exerciţii propuse 
 

  Toate exercițiile propuse din cadrul acestui capitol se vor rezolva cu ajutorul Microsoft 

Access. 

1. Să se creeze baza de date gestiune_laboratoare  

2. Sa se creeze tabelele aparatura, functii, lab_ap, laboratoare, lucrari_de_lab, lucrarilab_aparate 

şi responsabili 

3. Să se aplice regula de validare prezentată anterior 

4.  Să se defineasca legăturile dintre tabelele existente şi să se creeze diagrama bazei de date  

5. Să se sorteze aparatele în ordine invers alfabetică a denumirii 

6. Să se ordoneze lucrările de laborator în ordinea crescătoare a câmpului ID_responsabil 

7. Să se afişeze toată aparatura care are curent alternativ în denumire 

8. Să se creeze un nou formular pentru tabela laboratoare 

9.  Să se introducă în tabela laboratoare încă două câmpuri denumite suprafata şi capacitate cu 

valorile de mai jos şi să se adauge în formularul anterior creat şi câmpurile care lipsesc 

laboratoare 

ID denumire adresa contact ID_responsabil suprafata capacitate 

1 Laborator de CAD in 

electromagnetism si circuite 

electrice 

Str. Baritiu nr. 

16B 

332458 1 60 20 

2 Laborator de compatibilitate 

electromagnetica 

Str. Dorobantilor 

71-73 

251445 4 102 40 

3 Laborator de campuri electrice 

intense 

Str Baritiu, 356 264725 3 60 15 

4 Laborator de metode numerice Str. Baritiu nr.26 154822 1 42 14 

5 Laborator de bazele 

electrotehnicii 

Str. Baritiu nr.26 256545 1 80 30 

6 laborator inginerie medicala Str. Baritiu nr.26 187412 2 56 15 

 

10. Să se creeze formularul pentru tabela aparatura folosind comanda Blank Form 

11. Să se creeze un formular pentru tabela lucrarilab_aparate care să fie create dintr-un Blank 

Form şi care să conţină Combo Box pentru ID_lucrare de unde utilizatorul să poată alege între 

valorile 1 şi 10 

12. Introduceţi încă un câmp în tabelul responsabili 

13. Să se afișeze toate câmpurile tabelului responsabili 

14. Să se ascundă câmpul ID_funcție 



15. Să se însereze codul de mai jos în SQL View și să se urmărească modul de afișare al celorlalte 

vederi, precum și rezultatul; se vor afișa laboratoarele care au ca responsabili pe reponsabilul 

cu ID-ul 1. 

SELECT lab.denumire 

FROM laboratoare lab, responsabili r 

WHERE lab.ID_responsabil=r.ID AND lab.ID_responsabil=1; 

16. Să se afișeze denumirea laboratoarelor și numele și prenumele responsabilului de aceste 

laboratoare, în ordine invers alfabetică a numelui și prenumelui responsabilului 

17. Să se creeze un raport pentru tabela aparatură 

18. Să se sorteze raportul aparatura după dată de la cea mai veche dată de expirare a garanției la 

cea mai nouă 

19. Să se exporte raportul în format PDF 

20. Să se creeze un raport prin care să se afișeze laboratoarele cu aparatele care le aparțin grupate 

după aparatură cu Report Wizzard 

 

 
 

 


